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Introduction

System requirements

· Operating system

· Symbian Epoc32 (ER5)

· Hardware support

· Psion Series 5MX 

· Ericsson MC218 

· Psion Series 7/Netbook

· Psion Revo/Revo Plus 

Installing 5FX

· PC Installation Procedure

· Connect your machine to your PC

· Switch your machine’s Remote Link on (CTRL+L)

· Run PSIwin on the PC

· Double-click the 5FX.SIS entry from within the Zip archive record to start the SIS installation

· Follow the installation prompts

· Epoc installation

· Connect your machine to the PC and run PsiWin

· Copy 5FX.SIS to your machine

· Double-tap the icon and follow the prompts

Uninstalling 5FX

Because the application creates and maintains thumbnail cache files you should use the following procedure to ensure all 5FX files are removed from your machine:

· Select the uninstall option from the tools
· Select exit from the file menu

· Select add/remove from the control panel

· Select 5FX from the list then press the DEL key

Gathering images

Background

5FX displays and manages images created in the MBM picture file. If you are new to graphics on Epoc32 then you may find the next section useful, however experienced users should move straight to Converting Video Clips.

Screen capture

You can capture the screen of your machine as an MBM image file by pressing Ctrl+Shift+Fn+S.

Draw/Sketch

If your machine has a Sketch application, then it should be able to import/export images in MBM format. 

Converting still images

Converting on the PC

Select the PC images you wish to convert and copy them to a new empty folder. This ensures any changes will not effect your PC viewing.

Due to its small screen size, you may have to adjust some pictures before viewing them on your machine. Although 5FX can zoom and change colour mode, you should perform these operations on your PC where possible to take advantage of its faster processing.

Image resizing

When the image is much bigger that you machine’s screen, 5FX can scroll the image from top to bottom in a slide show (tools menu/options). If you do not want to scroll, then you can reduce the size of image so that all of it will be visible, however some images give better results if they are slightly bigger than the screen and positioned in Preview mode.

Colour mode selection

The Series 7 and NetBook can display 256 colour while the other supported devices display 16 shades of grey. Use your PC graphics software to switch the images graphic mode as close as possible to your machine’s colour maximum mode.

Processing

Save the PC picture in BMP format, and then use Symbian’s bmconv.exe (supplied on the PSIwin CD that came with your machine) to convert the image into MBM format:

 256 colour MBM file
C:\> bmconv EpocFile.mbm /c8PcFile.bmp
16 grey scale MBM file
C:\> bmconv EpocFile.mbm /4PcFile.bmp

Converting on Epoc32

There are a number of Epoc32 programs that convert JPG image files to MBM. While these instructions may work with many file formats, JPG files are small and quicker to copy to your machine than BMP files. If you do not already have any conversion software, take a look at nConvert at www.neuon.com.

· Use a PC to adjust image size and colour mode if required, then save your image in JPG format.

· Copy the file to your machine

· Load the JPG into your conversion software

· Save the image as an MBM file

Converting video clips

The MBM file format can be used to store multiple images which can be played back one after the other to produce flick-book style animation. 5FX allows you to control the speed and direction, loop and repeat of these clips. 

Video conversion

· Use the following steps to convert a video clip to MBM 

· Create stills from a clip 

· Convert image clips to MBM format (see Converting Still Images)

· Reassemble MBM stills into a single MBM file

Creating stills

Most PC movie players have an option to advance the movie a frame at a time. If your clip is fairly short, you could screen print each frame (ALT+PrintScrn) and paste the results into the Windows Paint program. Save the output as a BMP file then advance movie to the next frame and repeat until all frames have been processed.

When dealing with more that a few frames, an AVI extractor like Michael Caracena AVI extractor (www.netsavant.com/caracena)  can drastically reduce the time needed to complete this task.  

Reassemble MBM stills

Creating MBM animations on the PC

BMCONV can create a single MBM file given multiple BMP files. Because this utility runs on the PC, it is probably one of the fastest ways to reassemble the frames:

· Enter the follow command in a DOS box:
C:\> bmconv animate.mbm /c8PcFrame1.bmp PcFrame2.bmp…

Creating MBM animations on your machine

If your animation is fairly short, you can use one of the Epoc picture conversion programs to load each BMP/JPG frame appending the resulting output in a MBM file. This can be quite tedious if the program does not have any batch conversion functions. You can save time by using Macro5 (www.geocities.com/SilliconValley/Pines/1215 ) to record your keystrokes to automate the process.

Using 5FX

Discovering images

Starting up

Tap the 5FX icon on the Extras Bar and, after a brief loading period, the application opens with its main view. The left pane displays an Explorer interface and thumbnails are displayed in the right if the current folder has any images. 
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Navigation and selection

· Changing folders

· Tap on a folder icon to expand or contract it

· Use the slider control to move around the window

· You can use the up/down arrow keys to move around the Explorer pane

Selecting thumbnails

To select a single image, tap the thumbnail and it switches to reverse video to indicate that it has been selected.  If you now tap another thumbnail, the first is de-selected and the new thumbnail highlighted. 

The following keys can be used to select multiple images:

· Hold down the Ctrl key and tap one or more thumbnails to select multiple images

To select a range of images:

· Tap a thumbnail to select the start image

· Hold down the SHIFT key and tap another thumbnail to select the end image. All images between the start and end are highlighted

Preview mode

If you tap a thumbnail that has already been selected you are taken into preview mode where you can fine tune how your image will be displayed in a slide show. Tap the image in Preview mode to exit back to the main thumbnail view.

Single image previews

If your image is larger than the screen, it is displayed along with scrollbars that can be used to adjust its screen position. 5FX remembers the position of the sliders and uses them to soft-crop the image during a slide show. Because the original image is not changed, the soft-cropping region can be re-adjusted later on if required. If the image is smaller than the physical screen it is still displayed but no adjustments can be made.

Video clip previews

Additional controls appear when previewing a video clip that allow you to loop and adjust playback. 
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 File menu

The following commands are available on the File menu:

Rename 

Use this option to name one or more selected images. The new names will end with a three-digit sequence number.

· Select one or more thumbnails, then tap the rename option on the file menu

· Enter a new name for your selection

· Adjust the image index field if you do not want the index to start from 001

Delete 

The delete option removes one or more images and associated thumbnails from your machine:

· Select one or more thumbnails

· Tap the delete option on the file menu

· Press  ENTER to confirm the delete

Properties 

Displays the following image properties:

· Date of last change

· Dimensions (in pixels)

· File size (bytes,  KB or MB)

Animated MBM images have the following additional properties:

· Reverse flag

· Number of frames

New folder 

Creates a new sub-folder underneath the currently selected folder. 

· Enter the name of the new folder in the dialog box

· Press ENTER to create the folder or ESC to cancel

Delete folder 

This option removes a folder and any known MBM images within:

· Ensure the folder you wish to delete is highlighted in the left-hand pane

· Select the Delete folder option from the File menu

· Press ENTER to confirm the deletion

The delete option will not remove a folder if it contains sub-folders or non-MBM files.

Verify cache 

If you delete a known image from outside of 5FX, its thumbnail and index information remains on your storage. This option deletes all orphaned thumbnails and compacts all remaining index records and ensures that you are not wasting any storage.

Generate thumbnails

When you zoom down an image the associated thumbnail is not automatically regenerated because unless the new image is smaller than the thumbnail, the original thumbnail is still valid. Use this option to regenerate the thumbnail based on the current image settings.

Close 

Exits 5FX.

Edit

Zoom to

Use this option to reduce the size of one or more images:

· Select one or more thumbnails

· Select the Zoom option from the edit menu

· Enter a zoom factor and press return to reduce the image

Note:

You can use the silk-screen side buttons as a short cut to this option.

Cut

Use this option to move one or more images between folders:

· Select one or more thumbnails

· Select cut from the edit menu

· Expand the folder pane until the destination folder is highlighted

· Select paste from the edit menu

Copy

Use this option to produce copies of one or more images, leaving the original images in place:

· Select one or more thumbnails

· Select copy from the edit menu.

· Expand the folder pane until the destination folder is highlighted

· Select paste from the edit menu.

Select all

Selects all thumbnails in the current folder, the following options can then be applied to a selection:

· Rename

· Delete

· Regenerate thumbnail

· Cut

· Copy

· Paste

· Zoom to

· Slideshow

Invert selection

This option de-selects all selected thumbnails and selects all de-selected thumbnails. If you wish to select most of the images in a folder, it may be quicker to select the unwanted images then tap the invert option from the edit menu.

View

The View menu offers the following options:

Show toolbar

Use this option to switch the side toolbar on/off.  The side toolbar provides short-cut access to the following options (depending on machine type):

· Slide show

· Options

· New folder

· Delete folder

· Refresh

· Help

Show top toolbar

The top toolbar provides shortcut access to the following functions:

· Cut

· Copy

· Paste

· Delete

· Properties

· Sort by name

· Sort by size

· Sort by date

· FX selection

Slide Show

Use this option to display your still and animated images. If FX are enabled (tools menu/options) then each still image is displayed using a randomly selected FX module. The following key presses are available during a slideshow:

Key
Effect

Space
Pause the slide show until SPACE is pressed again.

ESC
Press this key to abort the slide show. The screen clears and you are prompted to press ENTER to return to the thumbnail display or ESC to quit 5FX.

Sort by

Use this option to control the order that thumbnails are displayed in the right-hand pane. You can sort your images by:

· Name

· Date

· Size

Refresh

This option causes the current folder to be re-scanned for images and then updates the thumbnail display.

FX

The FX menu offers the following options:

Open transition

If your machine supports OPL development, this option will run the editor to allow you to change the selected FX source. Use the editor to make any changes to the FX, then translate it to create an OPO module. Select the Close option on the File menu, to return to 5FX.

New transition

Use this option to develop a new FX module. Note all module names must be unique within the FX folder and the module name must match the file name.

Select FX

Normally FX are selected randomly, however there may be times when you wish to run the slide show with a specific one. This option allows you to choose a single FX that is applied to all still images in a slide show.

Toolbar controls

You can also use the FX selector in the top toolbar to select FX. Tap the left and right arrows to change the effect or tap the effect button to toggle between a random and the current selection. 

Tools

Options

Use this option to fine tune your slideshow... the following options are available:

Slideshow setting
Function

Replay
Replays the entire slideshow when it reaches the end. Press ESCAPE to stop.

Display refresh
Clears the screen between slides.

Delay


The pause between images (in seconds).  Set this value to 0 if you want to use the keyboard to advance the slideshow.

Visual FX
Switches image transition FX on/off.

Image scatter
Displays the image in a random screen position. Clear this field if you want your images centred.

Random playback
Juggles the order or the slideshow. Leave this field blank if you want the slides to appear in the current sort order.

Shortcut keys

Keyboard shortcuts provide quick access to the programs main features, and learning them frees up the screen space needed for the shortcut toolbars. 

To
Press

Rename one or more files with new names and a running sequence number.
Ctrl+R

Delete one or more selected file.
Ctrl+D

Display the properties of an image.
Shift+Ctrl+P

Create a new folder.
Ctrl+F

Delete an existing folder.
Shift+Ctrl+D

Verify files in the thumbnail cache.
Shift+Ctrl+V

Regenerate one or more selected image thumbnails.
Ctrl+G

Quit the program.
Ctrl+E

Reduce the current image size.
Ctrl+Z

Cut one or more selected images from a folder.
Ctrl+X

Copy one or more selected images in a folder.
Ctrl+C

Copy or move selected files to a new folder.
Ctrl+V

Select all files in a folder.
Ctrl+A

Invert the list of selected files.
Ctrl+I

Display the side toolbar.
Ctrl+T

Display the top toolbar.
Shift+Ctrl+T

Slide show folder/selected images.
Ctrl+S

Refresh the current folder.
Shift+Ctrl+R

Open an existing FX transition.
Shift+Ctrl+O

Create a new FX transition.
Shift+Ctrl+N

Select (lock) a specific FX.
Shift+Ctrl+S

Change slide show options.
Ctrl+O

Display on-line help.
Ctrl+H

Display version and registration information.
Shift+Ctrl+A

FX modules

Creating modules

5FX provides an open interface to image transitions, allowing you to extend the product by adding your own or downloading from others. Transitions are simply user-written OPL procedures that are selected to display an image in a slide show. 

Parameters:  

Setting
Value

Image_Id%
The bitmap id number of the image to be displayed.

scr_x%
The x position to the top left pixel in the bitmap.

scr_y%
The y position to the top left pixel in the bitmap.

image_w%
Specifies the width of the bitmap to display.

image_h%
Specifies the height of the bitmap to display.

increment%
A random number between 1 and 10 that can be used to time your transitions.

Example

REM*****************************************************************
REM Module:
Blinds.opo
REM
Abstract:
REM

Horizontal blinds 
REM Author:
Colin Lesforis March 23 2001
REM******************************************************************REM
PROC Blinds:(image_id%,scr_x%,scr_y%,image_w%,image_h%,increment%)
LOCAL image_x%,image_y%,base_y%,ThisInc%,slice%,k%

  slice%=image_w%/increment%
  DO
    base_y%=scr_y%+ThisInc%
    image_y%=ThisInc%
    DO
      gAT scr_x%,base_y%
      gCOPY image_id%,image_x%,image_y%,image_w%,1,3
      image_y%=image_y%+slice%
      base_y%=base_y%+slice%
      k%=key
      if k%<>0
         break
      endif
    UNTIL image_y%>image_h%
    ThisInc%=ThisInc%+1
  UNTIL ThisInc%=slice%
  RETURN k%
ENDP

Notes

· 5FX uses the file name as the name of the main module to load and execute, therefore the above example must be saved in a file called blinds

· The example uses the key command to all it to respond to a user key press mid-cycle

Installing FX modules

Free FX modules can be downloaded from www.stampark.co.uk/downloads. Use the following procedure to install them on your machine:

· Unzip the 5FX-FXnn.ZIP to the drive:\5FX\FX folder – where nn is two-digit numeric value and drive is the letter of the drive where the application is installed

· Start/restart 5FX

Contact 

If you have any enhancement request or find any bugs, please drop a line to support@stampark.co.uk

Enjoy.

Legal

Notice to users: 

Carefully read the following legal agreement. Use of the software provided with this agreement (the "software") constitutes your acceptance of these terms. If you do not agree to the terms of this agreement, promptly remove the software together with all copies from your computer. User's use of this Software is conditioned upon compliance by user with the terms of this agreement.

The software is protected by copyright law and international treaty provisions. You acknowledge that no title to the intellectual property in the software is transferred to you. You further acknowledge that title and full ownership rights to the software will remain the exclusive property of Colin Lesforis, and you will not acquire any rights to the software except as expressly set forth in this licence. You agree that any copies of the software will contain the same proprietary notices which appear on and in the software.

Reverse engineering. You agree that you will not attempt to reverse compile, modify, translate, or disassemble the software in whole or in part.

I do not warrant that the software is error free. I disclaim all other warranties with respect to the software, either express or implied, including, but not limited to, implied warranties of merchantability, fitness for a particular purpose and non-infringement of third party rights.

There is no liability for consequential damages. In no event shall I or my suppliers be liable to you for any consequential, special, incidental or indirect damages of any kind arising out of the delivery, performance or use of the software, even if I have been advised of the possibility of such damages. In no event will my liability for any claim, whether in contract, or any other theory of liability, exceed the licence fee paid by you.

StamPark Ltd.
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